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Terminology 
General GIS Terminology 

GIS ς Geographic Information System.  Any combination of spatial data (where it is) with tabular data 

(what it is). 

Vector data ς ά5ƛǎŎǊŜǘŜέ Řŀǘŀ ƛƴŎƭǳŘƛƴƎ ǇƻƛƴǘǎΣ ƭƛƴŜǎ ŀƴŘ ǇƻƭȅƎƻƴǎΦ  ¢ƘŜ Řŀǘŀ ȅƻǳ ƎŜƴŜǊŀƭƭȅ ƛƴǘŜǊŀŎǘ ǿƛǘƘ 

will be vector data. 

Raster data ς ά/ƻƴǘƛƴǳƻǳǎέ Řŀǘŀ ǎǳŎƘ ŀǎ ƛƳŀƎŜǊȅΦ  ¢ƘŜ ōŀŎƪƎǊƻǳƴŘ ƛƳŀƎŜǊȅ ȅƻǳ Ƴŀȅ ǳǎŜ ǿƛǘƘ ȅƻǳ 

project is considered raster data. 

Feature ς any item about which you want position information. A feature may be a single point, a line, 

or a polygon 

Attribute - A value that describes a feature. Values for attributes are entered while collecting the data. 

An example of an attribute would be the name of a building, or the height of a tree. 

Layer ς A set of spatial features you will interact with. 

Table ς the non-spatial tables that you may interact with. 

 

GPS Terminology 

PDOP ς Positional Dilution of Precision, measure of the geometrical strength of the GPS satellite 

configuration. Estimates the amount of error in your position. 

SBAS/WAAS ς Satellite Based Augmentation System/Wide Area Augmentation System, used to increase 

real time accuracy of GPS in the field  

SNR ς Signal to Noise Ratio, a measure of the information content of the signal relative to the signal's 

noise. A higher number is desirable  

NMEA ς  National Marine ElectrƻƴƛŎǎ !ǎǎƻŎƛŀǘƛƻƴΩǎ ǎǘŀƴŘŀǊŘ ŦƻǊ Dt{ ƻǳǘǇǳǘ Řŀǘŀ ǎǘǊƛƴƎ ŦƻǊƳŀǘ 

SSF ς file type that is created by Trimble GPS devices for post processing 

Post Processing ς differential correction using base station coordinates to correct data 

H-Star Processing ς post processing that uses three base stations, instead of one to correct data 



5 
1.  

Coordinate System ς a mapping system used to represent positions.  Examples are latitude/longitude, 

state plane, and UTM 

UTM ς Universal Transverse Mercator, a grid-based method of specifying locations on the surface of the 

Earth 

 

CartoPac Enterprise Terminology 

CartoPac Studio ς Studio is the tool used to configure database settings, create forms, download, and 

upload your data on the mobile device. 

CartoPac Enterprise Mobile ς The mobile application that runs on the mobile/handheld device. 

CartoPac Enterprise ς A term used to describe the suite of CartoPac products. 

CRPC ς CartoPac Remote Project Container. This is a file that can be exported from ArcMap or loaded 

onto a Mobile.  It mimics the download to the mobile, but stores the data in a file on your desktop 

machine. 

CSN ς CartoPac Solution File.  Users can export and import this file which contains the transfer settings 

created in Studio.  For example, if an administrator makes a change to the configuration, forms, or 

transfer settings, you can simply import the provided CSN to update these changes. 
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SECTION 1: GETTING STARTED WITH 

CARTOPAC ENTERPRISE MOBILE 

Starting CartoPac Enterprise Mobile and Opening Proje cts 

1. With the mobile device powered on, tap Ψ{ǘŀǊǘ Ҕ /ŀǊǘƻtŀŎ 9ƴǘŜǊǇǊƛǎŜΩ.  This will launch 
the CartoPac Enterprise Mobile application 

2.  Field users can enter the User ID when prompted upon the opening CartoPac Enterprise 
3. Once CartoPac Enterprise has opened you can now open a project.  Tap ΨCƛƭŜ Ҕ hǇŜƴΩ.*  
4. ¢Ƙƛǎ ǿƛƭƭ ōǊƛƴƎ ǳǇ ǘƘŜ ΨOpen Map DataΩ ƳŜƴǳΦ  {ŜƭŜŎǘ ŀ ǇǊƻƧŜŎǘ ǘƘŀǘ Ƙŀǎ ŀƭǊŜŀŘȅ ōŜŜƴ 

downloaded as well as the imagery (Background Map) 
ŀƴŘ ǘŀǇ ΨOpen BothΩΦ 

 

 

 

 

 

 

 

 

Note:  Upon initial download of software and project, opening CartoPac Enterprise will 

automatically open the last project and image downloaded to the mobile device. This 

ŦǳƴŎǘƛƻƴŀƭƛǘȅ Ŏŀƴ ōŜ ǘǳǊƴŜŘ ƻŦŦ ōȅ ƎƻƛƴƎ ǘƻ ΨCƛƭŜ Ҕ hǇǘƛƻƴǎΩ ŀƴŘ ǎŜƭŜŎǘƛƴƎ ǘƘŜ aŀǇ ǘŀōΣ 

then uncheck reload last project. 
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1.2 Copying CartoPac Enterprise Program File to Windows Start Menu 

The first time CartoPac is installed on a particular mobile device (or following a full clean or reset) the 

option to launch CartoPac will not show up on the Start Menu.  These steps will explain how to copy and 

paste this file into the Windows Start Menu for easy access.  

1. Click on Windows Start menu and select the Programs.  

 
2. Click on File Explorer.  

 
3. Click drop down arrow at the top, and select My Device.  

 
 

4. Locate the CartoPac Enterprise program file.  
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5. With the stylǳǎ ǇǊŜǎǎ ŀƴŘ ƘƻƭŘ ƻƴ ǘƘŜ ǇǊƻƎǊŀƳ ŦƛƭŜ ƛŎƻƴΦ ! άŎƻǇȅέ ǿƛƴŘƻǿ ƻǇǘƛƻƴ ǿƛƭƭ 

pop up and allow the user to copy the file to another location.  

 
 

6. Once this file has been copied you can select to paste it in your Windows/Start menu file 

location.  To get to Windows Start Menu click on the Windows folder, then click on Start 

Menu within the Windows folder. 

 
7. Tap and hold down on ǘƘŜ άōƭŀƴƪέ ǎǇŀŎŜ ŀǘ ǘƘŜ ōƻǘǘƻƳ of the screen and select paste 

from the pop up window. The user should now be able to see the Cartopac software in 

the Windows Start menu as well as be able to launch the application from this location.  
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1.3 User Interface, CartoPac Enterprise Mobile 

The CartoPac users interface is designed to be simple, easy to use and support a full range of 

functionality.  Once the map display is open, there are 3 primary tools used in interacting with the 

mobile solution. 

1. Menus. 

2. Toolbars and Icons. 

3. Map Display. 

 

 

1.3.1 Menus 

There are four menus available at the bottom of the map display.  These will be covered in more detail 

in Section 2. 

ü The óFileô menu allows users to open and save projects, add new features, and 

access the options dialog. 

ü The óEditô menu allows users to edit layer and table properties, as well as 

move existing points using GPS. 

ü The óViewô menu allows users utilize the Data and Multilayer Summary 

capability 9.1.1 Using Multilayer Summary, turn toolbars on and off, turn the 

map grid on or off, and fit the project extent on the screen. 

ü The óModeô menu has five sections, 

a) The GPS section where users can enable/disable the GPS, turn on/off 

GPS auto insert, and turn on/off GPS Auto Center. 

b) Single Layer Selection allows toggling between single and multiple 

layer inquiry and selection. 

c) The Navigation section which allows users to choose different types of 

Navigation modes. 

d) The measurement section, which allows users to choose different 

measurement options. 

e) The Main Mode section which allows users to view their current 

mode, and select between the main modes: Edit-View, Inquire, Zoom, 

and Navigation. 
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1.3.2 Toolbars and Icons 

While the CartoPac Enterprise Mobile application has many toolbars that contain tools that offer a wide 

array of functionality, this section will focus on the key tools and toolbars that are used most often in 

the field.  The toolbars will be covered in more detail in future sections. 

a. Main Toolbar 

The Main Toolbar Ŏƻƴǎƛǎǘǎ ƻŦ ŦƻǳǊ άǉǳƛŎƪ ŀŎǘƛƻƴέ ƛŎƻƴǎ ƭƻŎŀǘŜŘ ŀǘ ǘƘŜ ōƻǘǘƻƳ ǊƛƎƘǘ 

hand corner of the application next to the menus.  These four icons represent the 

majority of the functionality that is needed in the field. 

ü ΨNext ModeΩ ŀƭƭƻǿǎ ǳǎŜǊǎ ǘƻ ŎȅŎƭŜ ōŜǘǿŜŜƴ ǘƘŜ ΨEdit-ViewΩ ŀƴŘ 
ΨInquireΩ ƳƻŘŜǎΦ 

ü ΨNew RecordΩ ŀƭƭƻǿǎ ǳǎŜǊǎ ǘƻ ŀŘŘ ŀ ƴŜǿ ǊŜŎƻǊŘ ƻǊ ŦŜŀǘǳǊŜΦ 
ü ΨPick LayerΩ !ƭƭƻǿǎ ǳǎŜǊǎ ǘƻ ŀŎǘƛǾŀǘŜ ƭŀȅŜǊǎ ōȅ ǇƛŎƪƛƴƎ ƻƴŜ ƻŦ ǘƘŜ 

available layers from a list. 
ü ΨZoomΩ ŀƭƭƻǿǎ ǳǎŜǊǎ ǘo quickly cycle through four different zoom 

scales. 
 

Next we will take a look at the remaining toolbars available in CartoPac Enterprise Mobile.  From the 

Ψ±ƛŜǿΩ ƳŜƴǳΣ ǘŀǇ Ψ¢ƻƻƭōŀǊǎΩΦ  ¢Ƙƛǎ ǿƛƭƭ ŘƛǎǇƭŀȅ ŀ Ŧƭȅ-out menu with the various toolbars available in 

CartoPac Enterprise and a checkmark to signify if they will be displayed.  You can check or uncheck these 

toolbars by tapping with the stylus.  Some of the tools found on these toolbars will be discussed in 

greater depth in following modules. 

b. Feature Toolbar 

ü The feature toolbar allows 
users to create and edit 
features.  These tools will be 
discussed in section 2 and 3. 

c. GPS Toolbar 

ü The GPS Toolbar displays the current GPS status and position.  Users 
can enable and disable the GPS from this toolbar. 

d. Zoom Toolbar 

ü The Zoom Toolbar gives users the ability to zoom 

in/out, go to project extents and set scale. 
e. Offset Toolbar 

ü The Offset toolbar gives users the ability to utilize 

offsets to collect data. Offset data collection is 

covered in more detail in Module 7.  
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1.3.3 Map Display 

Once you have loaded a project, and adjusted the layer settings you may need to make 

basic adjustments such as zooming in or out, or panning/moving the map to a specific 

location. 

 

Zoom and Move functionality 

1. Tap the Zoom button  (next to the keyboard at the lower right) to 
zoom in from the current display scale four levels, then 
cycle back to the original scale. 
 

2. CƻǊ ƳƻǊŜ ȊƻƻƳ ƻǇǘƛƻƴǎΣ ǘŀǇ Ψ±ƛŜǿ Ҕ ¢ƻƻƭōŀǊǎΩ ǎŜƭŜŎǘ ǘƘŜ 
Ψ½ƻƻƳΩ ƻǇǘƛƻƴΦ  ¢Ƙƛǎ ǿƛƭƭ ōǊƛƴƎ ǳǇ ŀ ǘƻƻƭōŀǊ ǿƛǘƘ ǎŜǾŜǊŀƭ 
additional zoom functions, including Zoom Out, Fit to 
Screen and Drag Zoom.   

 
 

Note: To maximize the map display, turn the toolbars off when not in use.  

3. Move the map using your stylus.  Simply press the screen near the edge 
of the map view, wait for the cursor to change to a hand, and drag the 
image in the desired direction. 

 

Note: In Zoom box mode it is first important to unselect the Zoom box, before dragging 

the map. Otherwise CartoPac Enterprise will assume you are trying to zoom instead of 

trying to drag the map.  

 

4.  A scale bar and zoom buttons are 
available on screen when the zoom 
toolbar is turned off.  The Zoom In, Zoom 
Out and Drag Zoom buttons have the 
same functionality as their counterparts 
on the Zoom toolbar. 
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1.4 Closing CartoPac Enterprise Mobile 

 

While it may seem intuitive to close the application 

usƛƴƎ ǘƘŜ ά·έ ŀǘ ǘƘŜ ǘƻǇ ǊƛƎƘǘ ƘŀƴŘ ǎƛŘŜ ƻŦ ǘƘŜ 

application, in a mobile device this actually only 

minimizes the application.  To minimize and restore the 

application: 

 

o CƛǊǎǘΣ ǘŀǇ ǘƘŜ ά·έ ƛƴ ǘƘŜ ǘƻǇ ǊƛƎƘǘ ƘŀƴŘ 
corner.  The application will minimize but 
there is a small graphic in the lower right 
hand corner that signifies that the 
application is still running. 

o Next, tap the graphic to bring the 
application back to the forefront.  

 

To exit the application: 

o {ŜƭŜŎǘ ΨCƛƭŜΩ ŦǊƻƳ ǘƘŜ Ƴŀƛƴ ƳŜƴǳ ŀƴŘ ǎŜƭŜŎǘ Ω9ȄƛǘΩΦ 
 

Module 2 - Collecting Data with CartoPac Enterprise Mobile 
 

¶ Objective:  Create new point, line and polygon features in the field using CartoPac 
Enterprise Mobile and a GPS. 

 

¶ Topics Covered: 
o Creating New Point Data on the Mobile Device 
o Creating New Line Data on the Mobile Device 
o Creating New Polygon Data on the Mobile Device 

 

¶ Requirements 
o CartoPac Enterprise Mobile loaded on a mobile device 
o Enabled GPS 
o Project loaded on the mobile device 
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2.1 Collecting New Point Features 

1. First, ensure that the GPS is enabled.  In order to enable the GPS, tap the GPS icon 
with your stylus.  Once the GPS is enabled and has 
acquired a position, the GPS icon will display the 
number of available satellites. 

 

 

 

 

 

 

 

2. bŜȄǘΣ ǘŀǇ ǘƘŜ Ψ!ŘŘ bŜǿ wŜŎƻǊŘΩ ōǳǘǘƻƴ ƻƴ ǘƘŜ CŜŀǘǳǊŜ toolbar. 
 

 

3. ¢Ƙƛǎ ǿƛƭƭ ōǊƛƴƎ ǳǇ ǘƘŜ Ψ!ŘŘ bŜǿ wŜŎƻǊŘΩ ƳŜƴǳΦ  Although some workflows are 
specific to a particular project, this will cover the basic 
steps for adding a point. Select the point layer you wish 
to add a new point feature to, from the drop down 
wƛƴŘƻǿΣ ŀƴŘ ǘƘŜƴ ǘŀǇ ǘƘŜ Ψ/ǊŜŀǘŜΩ ōǳǘǘƻƴΦ   

 

 

 

 

 

 

 

4. A new point feature will be created using the data collected by the GPS.  If you have 
custom forms, your form will appear for data entry.  
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Note: ²ƛǘƘ ΨDt{ !ǳǘƻ LƴǎŜǊǘΩ ŎƘŜŎƪŜŘΣ Dt{ Řŀǘŀ ǿƛƭƭ ōŜƎƛƴ logging as soon as the user taps create unless 

the project was built with a summary control driven workflow.  

2.2 Collecting New Linear Features 

1.  First, ensure that the GPS is enabled.  In order to enable the GPS, tap the GPS icon 
with your stylus once the GPS is enabled and has 
acquired a position, the GPS icon will display the 
number of available satellites. 

 

 

 

 

 

 

 

 

2. bŜȄǘΣ ǘŀǇ ǘƘŜ ΨAdd New RecordΩ ōǳǘǘƻƴ ƻƴ ǘƘŜ Feature toolbar. 
 

3. ¢Ƙƛǎ ǿƛƭƭ ōǊƛƴƎ ǳǇ ǘƘŜ ΨAdd New RecordΩ ƳŜƴǳΦ  {ŜƭŜŎǘ ǘƘŜ ƭƛƴŜ ƭŀȅŜǊ you wish to 
add a new line feature to, from the drop down window, 
ŀƴŘ ǘƘŜƴ ǘŀǇ ǘƘŜ ΨCreateΩ ōǳǘǘƻƴΦ       
       
       
       
       
       
       
       
       
   

 
 
 
            
       

4. A new line feature will be created using the Data collected by the GPS as the user 
moves along the path of the line.     
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5. A new line feature will be created using the data 
collected by the GPS.  If you have custom forms, your 
form will appear for data entry after you have finished 
collecting coordinate data.  

 

6. Often an obstacle will be encountered and a 
continuous line cannot be completed.  In this 
circumstance the edit feature toolbar can be very 
useful in allowing a field user to continue mapping a 
feature. PƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ǘƘŜ ΨLƴǎŜǊǘ ±ŜǊǘŜȄΩ feature 
covered in section 9.4 Editing Spatial Data on the 
Mobile Device 

 
 

Note: This method can also be used when an off line feature must be created before the 
line end is reached.  

 
 

2.3 Collecting New Polygon Features 

1. First, ensure that the GPS is enabled.  Once the GPS is enabled and has acquired a 
position, the GPS icon will display the number of available satellites.  If you need to 

enable the GPS, tap the GPS icon with your stylus. 
 

 

 

 

 

 

 

 

 

2. bŜȄǘΣ ǘŀǇ ǘƘŜ ΨAdd New RecordΩ ōǳǘǘƻƴ ƻƴ ǘƘŜ Feature toolbar. 
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3. ¢Ƙƛǎ ǿƛƭƭ ōǊƛƴƎ ǳǇ ǘƘŜ ΨAdd New RecordΩ ƳŜƴǳΦ  {ŜƭŜŎǘ ǘƘŜ ǇƻƭȅƎƻƴ ƭŀȅŜǊ ȅƻǳ ǿƛǎƘ ǘƻ ŀŘŘ 
ŀ ƴŜǿ ǇƻƭȅƎƻƴ ŦŜŀǘǳǊŜ ǘƻΣ ŦǊƻƳ ǘƘŜ ŘǊƻǇ Řƻǿƴ ǿƛƴŘƻǿΣ ŀƴŘ ǘƘŜƴ ǘŀǇ ǘƘŜ ΨCreateΩ 
button.   

 
Note: ²ƛǘƘ ΨDt{ !ǳǘƻ LƴǎŜǊǘΩ ŎƘŜŎƪŜŘΣ Dt{ Řŀǘŀ ǿƛƭƭ ōŜƎƛƴ ƭƻƎƎƛƴƎ 

as soon as the user taps create.  

 

 

 

 

 

 

 

4. A new Polygon feature will be created using the Data collected by the GPS as the user 
moves along the path.   

 

5. If you have custom forms, your form will appear for 
data entry after you have finished collecting 
coordinate data.  

 
Often an obstacle will be encountered and a continuous 

line cannot be completed.  In this circumstance the edit 

feature toolbar can be very useful in allowing a field user 

ǘƻ ŎƻƴǘƛƴǳŜ ƳŀǇǇƛƴƎ ŀ ŦŜŀǘǳǊŜΦ tƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ǘƘŜ ΨLƴǎŜǊǘ 

±ŜǊǘŜȄΩ ŦŜŀǘǳǊŜ ŎƻǾŜǊŜŘ ƛn section 9.4 Editing Spatial Data 

on the Mobile Device 

 

   

 

             

             

2.4 Adding Related and Non-Spatial Data  

Often a form without spatial attributes will need to be entered in the field.  Usually this 
is related to a pyshical, spatial objectτsuch as an inspection of an existing pipe valve.  
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Most often this is acomplished with two sperate forms linked together by a unique 
attribte shared between the two items. 
 
In this scenario the spatial feature can be related to another table by use of a 

relationship control. Relationship controls allow you to establish connections between 

associated data in other tables.  

        

       

Note: Occasionally work flow will require collection of non-spatial data 

which is not related to a spatial feature, in this case, simply pick the 

ǘŀōƭŜ ŦǊƻƳ ǘƘŜ Ψ!ŘŘ bŜǿ wŜŎƻǊŘǎΩ ƳŜƴǳ ŀƴŘ ŜƴǘŜǊ Řŀǘŀ ŀǎ ǳǎǳŀƭΦ 

        

    

1. A relationship control within a form allows the user to see 
the associated data from related tables. To add a new related 
ǊŜŎƻǊŘΣ ǘŀǇ ǘƘŜ Ψ!ŘŘΧΩ ōǳǘǘƻƴΦ  

2. The custom form assigned to the related table will appear 
and data entry continues. 
 

 
3. LŦ ŀŘŘƛǘƛƻƴŀƭ ŀǘǘŀŎƘƳŜƴǘ ǊŜŎƻǊŘǎ ƴŜŜŘ ǘƻ ōŜ ŀŘŘŜŘΣ ǘƘŜ ΨNewΩ 

button can be used to enter another related record without 
returning to the parent form. 

 

 

4. ¢ŀǇ ΨhYΩ ǘƻ ǊŜǘǳǊƴ ǘƻ ǘƘŜ ǇŀǊŜƴǘ ŦƻǊƳΦ 
 
 

5. The relationship control will display all current 
related records.  To view or change a record, 
ƘƛƎƘƭƛƎƘǘ ŀƴŘ ǘŀǇ Ψ±ƛŜǿΧΩ  ¢ƻ ŘŜƭŜǘŜ ŀ ǊŜŎƻǊŘ ǳǎŜ ǘƘŜ 
ΨwŜƳƻǾŜΩ button. 

 

 

 
Note: {ƻƳŜ ǇǊƻƧŜŎǘ ǿƻǊƪ Ŧƭƻǿǎ Ƴŀȅ ƴƻǘ Ŏƻƴǘŀƛƴ ǘƘŜ ΨbŜǿΩ ōǳǘǘƻƴ 

feature. 
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SECTION 2: CARTOPAC 

ENTERPRISE MOBILE - FORMS 

AND BASIC SETTINGS 

Module 3 - CartoPac Enterprise Forms Overview 

 
¶ Objective:  Allow Users to get a basic understanding of CartoPac Enterprise Custom-

Built Forms. 
 

¶ Topics Covered:  
o Custom-Built Forms Overview 
o Data Entry Options 
o Types of Forms Controls 

 

¶ Requirements:  
o Sample project 
o Project transferred to mobile device 
o Mobile device running a supported mobile operating system 

 

3.1 Custom Built Forms  

What is a CartoPac Enterprise Form?  

¶ Represent the workflow in the field as it relates to the database used to store 
the collected data 

¶ A structured way for field users to interact with and collect data 
 

What types of data can be entered in a form? 

¶ Standard Database and GIS data formats including date/time, text, numeric, 
logical (T/F), memos, photographs and more. 

 

How are forms linked to a project and how are they distributed?  

¶ Forms are imported with preconfigured links to the database tables and 
layers as an administrative function. 
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3.2 Data Entry Options Using CartoPac Enterprise Forms  

Data entry using forms is similar to entering data on an internet form.  There are many different 

ǘȅǇŜǎ ƻŦ άŎƻƴǘǊƻƭǎέ ǎǳŎƘ ŀǎ ŘǊƻǇ Řƻǿƴ ƳŜƴǳǎΣ ƻǊ ŎƻƴǘǊƻƭǎ which you manually type data into 

using the keyboard or a number pad.  Some controls have more advanced functions such as 

calculating values like area or length.  On the mobile device, you can interact with all of the 

controls by using the stylus.  Some of the controls you may interact with are: 

1. In the Text Box Control, enter text from the virtual keyboard, number pad or 
calendar. 

 

 

 

 

 

 

2. In the Drop Down Control, click on the down arrow and 
make a selection from the drop down menu. 

 

 

 

 

 

3. In the Calculation Control, click on the menu to 
calculate value. 
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Module 4 ï Basic CartoPac Mobile Functionality 
 

¶ Objective:  Gain an overall understanding of the CartoPac Enterprise Mobile software by 
reviewing the features and functionality of the CartoPac Enterprise Mobile software.  
Users will also be introduced to the different type of data collection forms. 

 

¶ Topics Covered: 
o Basic Screen Navigation 
o Layer Settings 
o Modes 
o Other Options 

 

¶ Requirements:   
o Sample project 
o Project transferred to mobile device 

Mobile device running a supported mobile operating system 

4.1 Basic Screen Navigation 

Once the project is open in CartoPac Enterprise, navigation is done with pan and zoom tools. 

 

1. ¢ƘŜ ΨtŀƴΩ ǘƻƻƭ ƛǎ ŀŎǘƛǾŀǘŜŘ ǎƛƳǇƭȅ ōȅ ǇƭŀŎƛƴƎ ǘƘŜ ǎǘȅƭǳǎ ŀǘ ǘƘŜ ŜŘƎŜ ƻŦ ǘƘŜ 
screen, tap and hold then drag. 
 

Note: ¢ƘŜ Ψ½ƻƻƳ .ƻȄΩ ǘƻƻƭ Ƴǳǎǘ ōŜ ŘŜŀŎǘƛǾŀǘŜŘ ŦƻǊ ǘƘŜ Ǉŀƴ ǘƻƻƭ ǘƻ ōŜ ǳǎŜŘΦ 

2. ¢ƘŜ ȊƻƻƳ ǘƻƻƭǎ Ŏŀƴ ŀƭƭ ōŜ ŀŎŎŜǎǎŜŘ Ǿƛŀ ǘƘŜ ΨZoomΩ ǘƻƻƭōŀǊΦ 
a. Project Extents allows users to zoom in/out to the extent of the project at 

last save.  
b. Zoom Out allows the user to zoom out to twice the current 

viewing area. 
c. Zoom In allows the user to zoom in to half the current viewing 

area. 
d. Zoom Box allows a user to specify an area to zoom in on by 

clicking the mouse and dragging a zoom box.  CartoPac Enterprise 
Mobile will automatically rescale the map to the selected Zoom 
Box.  

e. Scale allows a user to input a desired scale and CartoPac 
Enterprise Mobile will automatically rescale to the desired scale. 
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4.2 Layer Settings 

 

Once you have opened your project you may wish to make changes regarding the way in which 

the data is displayed.  Edit Layers allows the user to make changes to the size, and color of each 

layer as well as change the order in which the layers will be 

drawn.  

4.2.1 Visualization 

1. Go to ΨEdit  >  LayersΩ 
 

2. ¢Ƙƛǎ ǿƛƭƭ ōǊƛƴƎ ǳǇ ǘƘŜ ΨLayersΩ ƳŜƴǳΦ  CǊƻƳ ǘƘŜ 
Layers menu you can adjust the color and size 
for each individual layer.  Select the layer that 
ȅƻǳ ǿƛǎƘ ǘƻ ŎƘŀƴƎŜ ŀƴŘ ǘŀǇ ΨPropertiesΩΦ  

 

3. ¢ŀǇ Ψ5ƛǎǇƭŀȅ /ƻƭƻǊΧΩ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ŎƻƭƻǊ ƻŦ ǘhe 
selected feature. 

 

4. !ŘƧǳǎǘ ΨLine WidthΩ ǘƻ ŀŘƧǳǎǘ ǘƘŜ ǎƛȊŜ ƻŦ ǘƘŜ 
symbol. 

 

5. ! ƭŀȅŜǊ ƛǎ ǾƛǎƛōƭŜ ƛŦ ǘƘŜ ōƭǳŜ ΨVΩ ƛǎ ǎŜǘΦ  ! ƭŀȅŜǊ ƛǎ 
!ŎǘƛǾŜ ƛŦ ǘƘŜ ǊŜŘ ΨAΩ ƛǎ ǎŜǘΦ  LŦ ȅƻǳ ƭƻƻƪ ŀǘ ǘƘŜ ǘƻǇ 
of the screen you will notice the active layer is 
listed.  In the graphic to the right, the active layer 
ƛǎ ά{ǳǇǇƻǊǘέΦ 

 

6. The order that layers will be drawn is controlled 
ōȅ ǘƘŜ ƻǊŘŜǊ ǘƘŀǘ ƭŀȅŜǊǎ ŀǊŜ ƭƛǎǘŜŘ ƛƴ ǘƘŜ Ψ[ŀȅŜǊǎΩ 
dialog.  To change the order, select a layer and 
ǳǎŜ ǘƘŜ ΨMove UpΩ ŀƴŘ ΨMove DownΩ ōǳǘǘƻƴǎΦ 

 

 



22 
1.  

 

4.3 Mode Menus 

Now that we have covered some of the basic functionality of 

CartoPac Enterprise Mobile, we will take a look at the 

functionality available from the Mode Menu.  The mode menu 

contains four sections. 

4.3.1 GPS Modes 

 This allows users to make changes to GPS functionality.   

1. ΨGPS EnabledΩ turns On/Off the GPS 
2.  ΨGPS Auto CenterΩ ǘǳǊƴǎ hƴκhŦŦ Dt{ !ǳǘƻ /ŜƴǘŜǊΦ  
²ƛǘƘ ΨGPS Auto CenterΩ ƻƴ ǘƘŜ ƳŀǇ ǿƛƭƭ ŀƭǿŀȅǎ ōŜ 
centered on the current GPS position. 

4.3.2 Layer Selection Mode 

Single Layer Selection allows toggling between single and multiple layer 

inquiry and selection. This mode makes it easy for a field user to identify 

multiple features within the map display. More details on this subject are 

listed in Module 9 Editing Data on the Mobile Device. 

4.3.3 Navigation Modes 

The navigation modes section allows users to choose which navigation mode to use. 

1. Goto Navigation allows users to enter coordinates which they can then navigate too. 
2. Feature Navigation allows users to navigate to a selected feature. 

 
4.3.4 Measurement Modes  

The measurement modes section allows users to perform 

measurement tasks right on the mobile device map display.  

1. Measure Distance turns On/Off the Measure Distance 
dialog. When an existing line feature has been selected 
on the mobile device, the field user can select points 
ŀƭƻƴƎ ǘƘŜ ƭƛƴŜ ŀƴŘ ǿƘŜƴ άaŜŀǎǳǊŜ 5ƛǎǘŀƴŎŜέ is enabled; 
the device will display measurements for the selected 
points.  

2. Measure Area turns On/Off the Measure Area dialog. 
When an existing polygon feature has been selected on 
the mobile device, the field user can select points along 
the feature and the device will display the measurement 
for the selected area.  
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4.3.5 Primary Modes 

Finally there are the primary modes.  These allow users to decide what the primary function will 

be in the current view.  The current primary mode is displayed at the bottom of the screen as an 

icon representation, as well as from the Mode menu where the current mode is represented 

with a check. 

1. Edit-View Mode 
ü Default option. 
ü Allows users to select and edit  
ü feature locations. 

 

2. Inquire Mode 
ü Allows field personnel to inquire 

on a feature and interact with 
the existing data. With Inquire 
mode enabled, tap on a feature (in the currently active layer).  This will bring up 
the data form.  This allows users to edit and add additional feature data.  

3. Zoom Mode  
ü /ƘŀƴƎŜǎ ǘƘŜ ǳǎŜǊΩǎ ƛƴǘŜǊŀŎǘƛƻƴ 
ƛƴǘƻ ǘƘŜ Ψ½ƻƻƳ .ƻȄΩ ŦǳƴŎǘƛƻƴΦ 

4. Navigation Mode 
ü Allows users to navigate to an 

existing feature or input 
coordinates depending on which navigation sub-mode is selected. 

 

 

4.4 Options Menu 

While this section has covered much of the basic functionality in CartoPac Enterprise Mobile, there are 

many features and options that have not been discussed.  We will not cover every option available in 

CartoPac Enterprise Mobile in this section, but we will discuss many of the most common features and 

functionality.  All of tƘŜ ƻǇǘƛƻƴǎ ŘƛǎŎǳǎǎŜŘ ōŜƭƻǿ Ŏŀƴ ōŜ ƭƻŎŀǘŜŘ ǳƴŘŜǊ ΨFile > OptionsΩ. 

4.4.1 Editing 

From the Editing Tab you can configure many options related to the way in 

which you collect and edit data 

1. Repeat Attribute can be turned on by selecting the Repeat Attribute 
checkbox. This feature allows users to pre-populate data from the 
previous times the form was filled out. CartoPac Enterprise Mobile 
Software can copy the data from the most recently created feature 
into a new feature.    
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2. Editing Enabled allows users to set whether editing will be allowed for various 
components of CartoPac EnterpriseΦ ό¢Ƙƛǎ ǿƛƭƭ ƻƴƭȅ ōŜ ŀŎǘƛǾŜ ƛŦ ά[ƻŎƪ 9ŘƛǘƛƴƎ hǇǘƛƻƴǎέ ƛǎ 
not set) 

3. Enable Advance Mode is for CartoPac Field Solutions internal use only.  (This will only 
be aŎǘƛǾŜ ƛŦ ά[ƻŎƪ 9ŘƛǘƛƴƎ hǇǘƛƻƴǎέ ƛǎ ƴƻǘ ǎŜǘύ 

4. Lock Editing Options locks the current editing options while checked.  
5. Password Protect All Lock Options makes it so the Lock Editing box cannot be 

changed without a password. 
 

 

 

4.4.2 Map 

1. Startup Options allows users to set whether the last project on 
CartoPac Enterprise Mobile should automatically be opened when 
CartoPac Enterprise Mobile is reopened.  

2. Auto Select automatically reads and opens any image set that is on a 
local SD Card; mapsets located on the SD Card may have pre-
defaulted map thresholds already set up. Imagery must be processed 
in CartoPac format in order to be used on the mobile device.  
 

3. Threshold allows users to specify the visible limits for background 
imagery on the mobile device.  
Once the project and imagery open, you may notice that the 
ōŀŎƪƎǊƻǳƴŘ ƛƳŀƎŜǊȅ ƛǎ ƴƻǘ ŘƛǎǇƭŀȅŜŘΦ  ¢Ƙƛǎ ƛǎ ŘǳŜ ǘƻ ǘƘŜ ΨDisplay 
ThresholdΩΦ  ¢ƻ ŎƘŀƴƎŜ ǘƘŜ ŘƛǎǇƭŀȅ ǘƘǊŜǎƘƻƭŘ Ǝƻ ǘƻ ΨFile > OptionsΩΦ  
CǊƻƳ ǘƘŜ ƻǇǘƛƻƴǎ ƳŜƴǳ ǘŀǇ ƻƴ ǘƘŜ ΨMapΩ ǘŀō ǘƘŜƴ ȅƻǳ Ŏŀƴ ŜƴǘŜǊ ŀ ǎǳƛǘŀōƭŜ ΨThreshold 
ScaleΩ ƛƴǘƻ ǘƘŜ ōƻȄΦ  ¢ƘŜ ƭŀǊƎŜǊ ǘƘŜ ƴǳƳōŜǊΣ ǘƘŜ ƳƻǊŜ άȊƻƻƳŜŘ ƻǳǘέ ȅƻǳ Ŏŀƴ ōŜ ŀƴŘ ǎǘƛƭƭ 
have the background imagery display.  This allows the user to set the threshold so 
background imagery only displays when zoomed in at a certain level.  This can be 
beneficial when using large sets of imagery that may require lots of processing power. 

4. Selection Tolerance allows users to specify within how many pixels CartoPac Enterprise 
Mobile will distinguish when users are selecting vertices. 

5. Cache sets the number of imagery tiles that will be loaded into memory at any given 

time. 
 

4.4.3 Units 

1. Coordinate Display ς allows user to set the coordinates to display current position in. 
2. Measurement Units ς sets the units that will be used for forms measurements and in 

navigation mode features  
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4.4.3 Backup 

As a default, backup will be turned on and will automatically 
prompt the user every ten minutes.  

 

1. The On checkbox on the Backup tab allows users to turn backup 
options on and off. Turning backup options off exposes users to 
potential data loss risk. In the event of a device failure, there will 
be no data backup.  

2. The Show Dialog checkbox determines whether the user will be 
prompted if they want to backup, or if the backup will happen 
automatically.  

3. Interval  allows users to specify how often CartoPac Enterprise 
will backup all data 
 
Note: If a form is open, backup will occur immediately upon closing the form.  

 

4.4.4 GPS 

 Covered in Module 5 

4.4.5 Offset 

 Covered in Module 7 

4.4.6 Navigation 

 Covered in Module 8 

4.4.7 Software 

The software tab can be used to view memory capacity and usage on the device.  Additional features on 

ǘƘƛǎ ǘŀō ŀǊŜ ŦƻǊ {Ǉŀǘƛŀƭ 5ŀǘŀ ¢ŜŎƘƴƻƭƻƎƛŜǎΩ ǳǎŜ ƻƴƭȅΦ 

4.4.8 Hardware 

Covered in Section 5.2 (GPS Hardware Configuration) and Section 7.2 (Configure CartoPac Enterprise for 

use with a Laser Range Finder) 

 

SECTION 3: CARTOPAC ENTERPRISE 

MOBILE - ADVANCED SETTINGS AND 

FUNCTIONALITY  
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Module 5 - Configuring and Using the GPS 
 

ü Objective:  Gain an overall understanding of configuring and using GPS in CartoPac 
Enterprise Mobile  

 

ü Topics Covered: 
o GPS Toolbar 
o GPS Hardware Configuration 
o Additional GPS Options 
o Obtaining a GPS Position 

 

ü Requirements:   
o Sample project 
o Project transferred to mobile device 
o Mobile device running a supported mobile operating system 

 

Warning:  There is a known limitation with the attempted post-processing of data collected over a 

span of greater than 7 days.  A Trimble SSF file will not support data collected for greater than 7 days. 

Any data collected after 7 days will not be post-processable, and post processing will be turned off on 

the mobile device if data collection is attempted for greater than 7 days on a single project.  The 

solution to this problem is to not collect data for greater than 7 calendar days in any individual 

project. For additional support and details regarding this topic please click the link below: 

http://trimble.resultspage.com/search?p=Q&ts=custom&w=ssf+files 

 

5.1 GPS Toolbar 

¢ƘŜ ŦƛǊǎǘ ōǳǘǘƻƴ ƻƴ ǘƘŜ ƭŜŦǘ ƘŀƴŘ ǎƛŘŜ ƻŦ ǘƘŜ ǘƻƻƭōŀǊ ƛǎ ǘƘŜ ΨGPS EnabledΩ ōǳǘǘƻƴΦ   

 

ü Tap this icon to enable the GPS. 
 

ü Once you have tapped the icon, The GPS will 
begin searching for a signal. 

  

ü When the GPS has acquired your position, 
the number of satellites available will be 
listed on the icon, as well as the current 

http://trimble.resultspage.com/search?p=Q&ts=custom&w=ssf+files
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PDOP and Elevation.   

 

ü You can view the GPS Status Constellation Map 
by tapping on the signal icon.  If the color is 
green, you have sufficient satellite coverage in 
order to collect data. For additional GPS support 
documents and troubleshooting please continue 
to the follow link: 

 
 
 

Note: See appendix for troubleshooting GPS lock. 
 

5.2 GPS Hardware Configuration  

5.2.1 Trimble GPS Configuration 

1. Go to the File menu, Options > DRIVERS 
tab. Under GPS TypeΣ ŎƘƻƻǎŜ ΨOtherΩΣ 
then select Trimble GPS from the drop 
down 

 

2. Tap Test to verify the configuration.  You 
should receive a message stating the GPS 
software is properly installed. 

 

3. Exit the program using File > Exit.  (This is 
a necessary step to enable the Trimble 
GPS options). 

 

4. Restart CartoPac Enterprise Mobile again 
to ensure the device is correctly 
configured for the Trimble GPS. 

 

5. Under the File menu, choose Options > 
GPS then the Settings tab. 
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6. {ŜƭŜŎǘ ǘƘŜ ΨMore SettingsΩ tab and set the COM port to the appropriate setting. 
COM port on the Trimble Geo XH device need to be set to COM 3. The COM port 
on the Trimble Juno ST device needs to be set to COM 7. 

 
 

7. ¢ŀǇ ΨOKΩ ŀƴŘ ǘƘŜƴ ǘŀǇ ǘƘŜ Test button to verify GPS connection 
 
Note: General GPS settings for Trimble Mobile devices can be auto-detected based on 
the mobile device that they are running.  
 

5.2.2 NMEA GPS Configuration 

ba9! /ƻƴŦƛƎǳǊŀǘƛƻƴ ƛǎ ǘƘŜ ǎŀƳŜ ŀǎ ŦƻǊ ǘƘŜ ¢ǊƛƳōƭŜ Dt{ /ƻƴŦƛƎǳǊŀǘƛƻƴ ŀōƻǾŜΣ ŜȄŎŜǇǘ Ψba9!Ω 

ǎƘƻǳƭŘ ōŜ ǎŜƭŜŎǘŜŘ ƛƴǎǘŜŀŘ ƻŦ ΨhǘƘŜǊΩ ƛƴ ǎǘŜǇ мΦ The collected data will only be post processable 

when using Trimble as a selected setting. 

5.3 Additional GPS Options 

1. Positions tab - Go to the File menu, Options > GPS tab, then the Positions tab.  From 
this menu you can set the desired sample interval and require that the user move a 
certain distance before the next vertex of a line or polygon will be collected. These 
settings may be useful when collecting large amounts of data and if memory is limited 
on the mobile device.   
 

2. Averaging tab ς Covered in Module 6 
 

3. Settings tabς Covered in Module 6 
 

4. Post Processing tab ς Covered in Module 6 
 

5. Accuracy tab ς Covered in Module 6 
 

6. Toolbar tab ς Go to the File menu, Options > GPS tab, then 
the Toolbar tab. 
ü Quality Display ς The user can also adjust the type of 

display used to indicate signal quality. 
ü Audible Warnings enables a chime that sounds each 

time the PDOP drops below the required limit. 
ü Show Status Dialogs enables pop-up messages to 

indicate loss of GPS lock, high PDOP, or GPS connecting. 
ü Show Common Errors-allows common errors to pop up. 

 


































